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SUMMARY

We present a protocol for analyzing and evaluating the relocalization of proteins
from the plasma membrane to chloroplasts. Some plant membrane-bound pro-
teins carry dual targeting signals, e.g., a membrane-anchoring N-myristoylation
motif and a chloroplast transit peptide. These proteins are predominantly tar-
geted to membranes; upon certain cues, however, they can undergo detachment
from membranes and relocalization to chloroplasts. This protocol combines im-
aging and biochemical analyses to track in a reliable and quantitative manner
the relocalization of proteins between subcellular organelles.
For complete details on the use and execution of this protocol, please refer to
Medina-Puche et al. (2020).

BEFORE YOU BEGIN

The experimental Solanaceae species Nicotiana benthamiana has become a cornerstone of host-

pathogen research, particularly in the context of innate immunity and defense signaling. Moreover,

its use as a plant model for cell biology has expanded considerably in recent years, rapidly gaining

popularity, particularly in studies requiring protein localization, interaction, or plant-based systems

for protein expression and purification. Transient protein expression requires four-week-old

N. benthamiana plants. Therefore, in order to implement this protocol, researchers must first

grow healthy N. benthamiana plants. Since N. benthamiana plants growth and Agrobacterium-

mediated T-DNA transformation require optimal light, humidity, and temperature conditions, we

recommend using environmentally-controlled growth facilities.

Preparing plant material and setting growth conditions

Timing: 4 weeks

Start preparing the plant material four weeks in advance as follows:

1. Sow N. benthamiana seeds in a well-watered soil mixture [3 parts of potting substrate (Pindstrup

Mosebrug A/S, Denmark) and 1 part of inorganic substrate (e.g., vermiculite)] and cover with a

transparent plastic lid or with cling-film. Stratify for 2 days at 4�C in the dark.
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2. Move pots to a controlled environment room or growth chamber set at 25�C, long-day conditions
(16 h light/8 h dark), and 100–150 mmol m�2s�1. Remove the plastic lids once the seedlings begin

to emerge (after 5–7 days).

3. Transfer the seedlings individually to plastic pots (e.g., 10 3 10 3 9 cm) filled with the same soil

mixture watered with fertilizer (20-20-20+TE, Xiamen Vastland Chemical Co., Ltd. China) and

cover with a transparent plastic lid for the next 5 days.

4. Check the plants every 2 days and water them to ensure that the soil is humid, while carefully

avoiding excess water in the tray, and fertilize once a week.

5. Four-week-old plants (five-leaf stage) are ideal to be used for transient expression and visualiza-

tion of protein subcellular localization.

CRITICAL: The quality and age of the plants are essential factors for achieving high protein

accumulation. Healthy plants are obtained only following good practices in a well-condi-

tioned growth chamber. A disease-free plant growth environment, careful watering, and

regular fertilizing are recommended for desired protein accumulation.

Alternatives: This protocol is suitable to be carried out in N. benthamiana leaves transiently

expressing the protein of interest. Alternatively, if stable transgenic lines are available (e.g.,

Arabidopsis), it will be necessary to carry out a timely setup.

Note: Plants can grow at different pace in different places, therefore rather than follow an age

stage a leaf stage can be used instead.

Note: This is an example of the conditions used to grow N. benthamiana plants, as shown in

Figure 1. To ensure a continuous supply of plants, we recommend sowing new batches of

seeds every week.

Elicitor and inhibitor preparation and storage

Timing: 1 h

Figure 1. Growing N. benthamiana plants in controlled conditions to transiently express proteins

(A) N. benthamiana seeds sown and covered with cling-film for germination.

(B) Germinated seeds. Remove the plastic lid once the seedlings begin to emerge.

(C) Seedlings transferred individually into plastic square pots and covered with cling-film for 5 days.

(D) Ten-day-old plants.

(E) Four-week-old plants ready to be used for transient protein expression.

Bar = 2 cm.
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For tracking the relocation of the protein of interest, translation must be stopped to chase steady-

state levels, and an elicitation is required to stimulate its release. Cycloheximide (CHX) is a well-

known eukaryotic translation inhibitor. In the case of effector or host defense proteins such as

Tomato yellow leaf curl virus (TYLCV) C4 protein and Arabidopsis thaliana CPK16, respectively, relo-

cation can be elicited by pathogenic elicitors, including the pathogen-associated molecular-pattern

(PAMP) flg22 (Felix et al., 1999), and the immunogenic peptide from Arabidopsis AtPep1 (Yamagu-

chi et al., 2006). For simplicity, in this protocol, we present the effect of flg22 on the TYLCV protein

C4. The impact of any other cues must be evaluated in each case.

6. The lyophilized flg22 peptide (TRLSSGLKINSAKDDAAGLQIA) from Pseudomonas syringae pv.

tomato DC3000 (Felix et al., 1999; Gomez-Gomez and Boller, 2000) was chemically synthesized

by ABclonal and carefully resuspended in ultra-pure distilled water to generate a storage stock at

a concentration of 10 mM. Then, 10 mL aliquots were prepared and stored at �20�C for at least

one year.

7. For protein synthesis inhibitor treatments, CHX was dissolved in dimethyl sulfoxide (DMSO) to a

30 mM stock solution. Then, 100 mL aliquots were prepared and stored at �20�C up to 2–

3 months.

8. Elicitors and inhibitors used in this protocol can be prepared as:

Note: Peptide stocks from lyophilized peptides should be prepared with extreme care to

avoid contamination.

Note: Peptides can stick to plastics and other surfaces. To prevent peptide loss, stocks can be

prepared using 0.1 M NaCl and 1 mg/mL bovine serum albumin (BSA) (Felix et al., 1999). Be

also aware of this when reusing reagent reservoirs and other materials.

Note: The stability of the flg22 peptide decreases at low concentrations. Therefore, it is rec-

ommended to keep peptides in concentrated stocks for long-term storage. The 10 mM flg22

stocks prepared in ultra-pure distilled water retain similar elicitor activity for at least one year

when stored at �20�C.

Note: Avoid thawing/freezing cycles of the working stock solutions. Flg22 solutions at lower

concentration than 100 mM should not be stored for longer than 2–3 months.

Plasmids and cloning

Timing: 7–10 days

To amplify and clone the gene of interest in the designated binary vector, which is used for Agrobac-

terium-mediated transformation and in planta expression, use any standard method. Here we

describe the plasmids and cloning protocol conducted for the viral ORF C4 from TYLCV, as

described in Rosas-Diaz et al. (2018) and Medina-Puche et al. (2020):

9. The gene sequence of C4 (NCBI: CAD33252) was amplified from the clone of TYLCV as the tem-

plate (AJ489258; NCBI:txid220938) using specific primers containing recombination sites [for

details, please refer to Rosas-Diaz et al. (2018)].

Reagent Stock concentration Working concentration Solvent

Flg22 peptide 10 mM 1 mM Milli-Q water

Cycloheximide (CHX) 30 mM 180 mM DMSO
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10. To generate the non-myristoylable version of C4, C4G2A, a single nucleotide was substituted in

the forward primer to replace G with A in the resulting protein [for details, please refer to Rosas-

Diaz et al. (2018)].

11. The fragment of interest cloned in the pENTR/D-TOPO� entry vector (Thermo Scientific) was then

recombined into the corresponding destination vectors through a Gateway LR reaction (Thermo

Scientific; https://www.thermofisher.com/in/en/home/life-science/cloning/gateway-cloning/

protocols.html).

Note: To generate C-terminal tagged proteins, the stop codon must be removed in the

reverse primers.

Note: Vectors from the pGWB and ImpGWB are published (Nakagawa et al., 2007a; Naka-

gawa et al., 2007b; http://shimane-u.org/nakagawa/gbv.htm) and available at Addgene. In

this protocol, pGWB5 from the pGWB list and pGWB505 from the ImpGWB list were used

as destination vectors for the Gateway LR reaction to generate the constructs pGWB5-C4

and pGWB505-C4G2A, respectively.

Note: For proteins with signal sequences or transit peptide sequences at the N-terminal of the

protein, it is advisable to fuse the tags at the C-terminus so as to not interfere with their native

subcellular localization.

Note: This protocol has been set up for a GFP tag. For other tags, both fluorescent and non-

fluorescent, subcellular localization must be evaluated beforehand.

Note: Gene sequences with specific deletions or site-directed mutagenesis can be amplified

using PCR-based methods [e.g., using the QuikChange Lightning Site-Directed Mutagenesis

Kit (Agilent Technologies)].

Preparation of the Agrobacterium tumefaciens inoculum

Timing: 3–5 days

12. Three to five days before the experiment, streak out A. tumefaciens (strain GV3101) harboring

the corresponding binary vectors on LB agar plates supplemented with appropriate antibiotics

and incubate at 28�C for two days. A newly transformedA. tumefaciens clone or a clone streaked

out from a glycerol stock stored at �80�C can be used.

13. One day before conducting the experiment, inoculate an A. tumefaciens clone harboring the

corresponding binary vectors in 5mL of liquid LBmedium containing the appropriate antibiotics

and grow overnight (12–16 h) at 28�C under continuous agitation (200 rpm).

14. Antibiotics used in this protocol can be prepared as:

Note: Other A. tumefaciens strains, such as AGL1, MOG101, or C58C1, are also frequently

used for agroinfiltration.

Reagent Stock concentration Working concentration Solvent

Rifampicin 25 mg/mL 25 mg/mL DMSO

Kanamycin 50 mg/mL 50 mg/mL Milli-Q water (filter sterilized)

Gentamycin 50 mg/mL 50 mg/mL Milli-Q water (filter sterilized)

Prepare 1 mL aliquots and store at �20�C up to 4–6 months.
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Note:Avoid thawing/freezing cycles of the stock solutions. Rifampicin and kanamycin are light

sensitive. Keep the aliquots tightly closed in light-resistant containers.

KEY RESOURCES TABLE

REAGENT or RESOURCE SOURCE IDENTIFIER

Antibodies

Mouse monoclonal anti-GFP (1:5,000) Abiocode, Agoura
Hills, CA, USA

Cat#M0802-3a

Goat anti-mouse IgG (H+L) HRP
conjugate (1:10,000)

Bio-Rad Cat#170-6516;
RRID:AB_11125547

Goat anti-rabbit IgG-
peroxidase (1:10,000)

Jackson Immuno
Research Laboratories

Cat#111-035-003;
RRID:AB_2313567

Rabbit anti-LhcB1 (1:10,000) Agrisera Cat#AS01 004; RRID:AB_1832079

Rabbit anti-RbcL (1:10,000) Agrisera Cat#AS03 037; RRID:AB_2175406

Bacterial and virus strains

Escherichia coli DB3.1 Transgen Biotech, China Cat#CD531

E. coli DH5a Transgen Biotech, China Cat#CD501

Agrobacterium tumefaciens GV3101 Shanghai Yixin Biological
Technology Co., LTD, China

Cat#AC1001

Tomato yellow leaf curl virus (TYLCV) Morilla et al., 2005
(Morilla et al., 2005)

NCBI:txid220938

Chemicals, peptides, and recombinant proteins

2-[N-Morpholino] ethanesulfonic
acid (MES)

Amresco Cat#E169

Acetic acid Sinopharm Chemical Reagent Cat#10000218

Acetone Sinopharm Chemical Reagent Cat#1000418

Acetosyringone Sigma-Aldrich Cat#D134406

Acrylamide Sangon Biotech Cat#B546017

Agar for bacterial culture medium Sinopharm Chemical Reagent Cat#10000561

Ammonium persulfate (APS) Sigma Cat#A3678

Bovine serum albumin (BSA) Sangon Biotech Cat#A600332

Bromophenol blue Sigma Cat#B0126

Coomassie brilliant blue R-250 Amresco Cat#0472

Cycloheximide (CHX) Xiya Reagent, China Cat#U5298

Dimethyl sulfoxide (DMSO) Sangon Biotech Cat#67-68-5

Dithiothreitol (DTT) Sigma Cat#43819

D-Sorbitol Sigma Cat#S6021

Ethylenediaminetetraacetic acid (EDTA) Sangon Biotech Cat#A500895

Ethylene glycol tetraacetic acid (EGTA) Sigma Cat# E3889

Ficoll 400 Sigma Cat#F2637

Flg22 peptide
(TRLSSGLKINSAKDDAAGLQIA)

ABclonal N/A

Gentamycin Sangon Biotech Cat#A100304

GFP-Trap Agarose ChromoTek, Munich, Germany Cat#gta-20; RRID:AB_2631357

Glycerol Sangon Biotech Cat#A600232

Glycine Sangon Biotech Cat#A610235

HEPES Sangon Biotech Cat#A600264

Kanamycin GoldBio Cat#K-120-50

Liquid nitrogen N/A N/A

Magnesium chloride (MgCl2) Sinopharm Chemical Reagent Cat#10012818

Methanol Sinopharm Chemical Reagent Cat#A10014108

PEG 6000 Sigma Cat#E3889

Percoll GE Healthcare Cat#17-0891-011

Ponceau S Sangon Biotech Cat#A100860

Potassium chloride (KCl) Sigma Cat#P9541

Potassium hydroxide (KOH) Sinopharm Chemical Reagent Cat#100019718

Potassium phosphate monobasic (KH2PO4) Sangon Biotech Cat#10017618

(Continued on next page)
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Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

Protease Inhibitor Sigma-Aldrich Cat#P8340

Protease Inhibitor SIGMAFASTTM Sigma-Aldrich Cat#S820

Q5� High-Fidelity DNA Polymerase New England Biolabs Cat#M0491S

Rifampicin Sigma Cat#R3501

Sodium bicarbonate (NaHCO3) Sinopharm Chemical Reagent Cat#10018960

Sodium chloride (NaCl) Sinopharm Chemical Reagent Cat#10019318

Sodium dodecyl sulfate (SDS) Sigma Cat#L5752

Sodium fluoride (NaF) Sigma Cat#30105

Sodium hydroxide (NaOH) Sinopharm Chemical Reagent Cat#10019718

Sodium orthovanadate (Na3VO4) Sigma Cat#450243

Sodium phosphate dibasic
anhydrous (Na2HPO4)

Sigma Cat#S7907

N,N,N,N-Tetramethylethylenediamine
(TEMED)

Sigma Cat#T9281

Triton X-100 Sigma Cat#78787

Tris-HCl Sangon Biotech Cat#600194

Tryptone Oxoid, Thermo Cat#LP0042

Tween-20 Sigma Cat#P9416

Yeast extract Oxoid, Thermo Cat#LP0021

Critical commercial assays

pENTR/D-TOPO Cloning Kit Invitrogen Cat#45-0218

Gateway LR Clonase II Enzyme Mix Invitrogen Cat#11797-020

QuikChange Lightning Site-
Directed Mutagenesis Kit

Agilent Technologies Cat#210518-5

PierceTM BCA Protein Assay Kit Thermo Fisher Scientific Cat#B23225

Experimental models: organisms/strains

Nicotiana benthamiana N/A N/A

Oligonucleotides

Primer for amplification of C4, forward:
CACCATGGGAACCACATC

Rosas-Diaz et al., 2018 N/A

Primer for amplification of C4G2A, forward:
CACCATGGCGAACCACATCTCCAT

Rosas-Diaz et al., 2018 N/A

Primer for amplification of C4 or C4G2A,
reverse without stop codon:
ATATATTGAGGGCCTC

Rosas-Diaz et al., 2018 N/A

Recombinant DNA

35S:C4-GFP Rosas-Diaz et al., 2018 pGWB5; NCBI:txid419549;
AB289768

35S:C4G2A-GFP Rosas-Diaz et al., 2018 pGWB5; NCBI:txid419549;
AB289768

Software and Algorithms

ImageJ Schneider et al., 2012
(Schneider et al., 2012)

https://imagej.nih.gov/ij/

GraphPad Prism 7 GraphPad Software https://www.graphpad.com/

LAS-X 2.01 Leica https://www.leica-
microsystems.com/products/
confocal-microscopes/

Other

Soil substrate Pindstrup Mosebrug
A/S, Denmark

N/A

Inorganic substrate (vermiculite) Shanghai Chunying Horticulture N/A

Fertilizer (20-20-20+TE) Xiamen Vastland Chemical
Co., Ltd. China

N/A

Petri dishes (90F) N/A N/A

Sterilization syringe filter
for �50 mL stock, 0.22 mm pore

Millipore Millex Cat#SLGP033RS

0.22 mm Millipore Express PES membrane Millipore Millex Cat#SLGP033NB

2-mL Centrifuge tubes Eppendorf Cat#0030120094

(Continued on next page)
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MATERIALS AND EQUIPMENT

Preparation of media

Timing: 1 h

LB medium

Formaking 1 L of LBmedium, mix 10 g bacteriological tryptone, 5 g NaCl, 5 g yeast extract in 500mL

of double-distilled water (ddH2O) with amagnetic stirrer until the powders are dissolved completely,

adjust the pH to 7.4 with NaOH, make up the volume to 1 L, and autoclave at 121�C for 20 min. Store

at room temperature (23�C–25�C). For solid LB, prepare LB medium as described above and add

7.5 g agar after pH adjustment.

Alternatives: Bacteriological tryptone can be replaced by bacteriological peptone.

Preparation of stock solutions

Timing: 1–2 days

� Acetosyringone (AS, 150 mM):Dissolve 294.3 mg AS in 10 mL of DMSO and store in 1 mL aliquots

at �20�C for up to 1 month.

Continued

REAGENT or RESOURCE SOURCE IDENTIFIER

15-mL Tubes GenBrick Cat#GP04-6500

50-mL Tubes GenBrick Cat#GP04-7500

Centrifuge Eppendorf; Scilogex 5810R, 5424; D3024

Incubator (28�C) Panasonic MIR-264-PC

Incubator (37�C) Panasonic MIR-154-PC

Magnetic stirrer with heater IKA IKA C-MAG HS7

Biopsy Punch with Plunger,
ID 4.0 mm, OD 4.36 mm, Green/Blue

Miltex� Cat#15110-40

Microscope slides FanYi Cat#7105p

Coverslips Citotest Cat#85850-0005

Tissue homogenizer QIAGEN TissueLyser II

Waring blender Local brand N/A

Revolver lab rotator Labnet Cat# H5600

Miracloth Millipore Calbiochem� Cat#475855-1R

PVDF membranes Millipore Cat#IPVH00010

Autoclave Sanyo MLS-3782

Confocal microscope Leica TCS SP8 Leica Microsystems

Water purification system Millipore Millipore integral 10

LB medium

Reagent Weight/Volume

Tryptone 10 g

Yeast extract 5 g

NaCl 5 g

Agar 7.5 g

ddH2O To make up the volume

Total 1 L

Store at room temperature (23�C–25�C) for maximum 2 weeks.
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� Ammonium persulfate (APS, 10% w/v): Dissolve 1 g APS in 10 mL of distilled water and store at

4�C for up to 3 weeks.

Note: APS undergoes decaying in solution, so replace the stock solution every 2–3 weeks.

� Bovine serum albumin (BSA, 1%w/v): Dissolve 100mg BSA in 10mL of distilled water, and store in

1 mL aliquots at 4�C or �20�C. If stored at 4�C or �20�C, BSA powders and BSA solutions are sta-

ble for 2 years.

� Cycloheximide (CHX, 30 mM): Dissolve 84.4 mg CHX in 10 mL of Milli-Q water or DMSO. Sterilize

with a 0.2 mm filter if necessary, and store in 1-mL aliquots at �20�C in the dark for up to 2–

3 months.

Note: CHX is a potent inhibitor of cytosolic protein synthesis, promotes the formation of mis-

folded and toxic translation products, is a dermal irritant, and its ingestion can be lethal.

Therefore, handle with extreme caution, wear gloves, goggles and lab coat. Follow the man-

ufacturer’s recommendations when preparing, storing, and handling CHX. In the event of

accidental exposure, consult the material safety data sheet provided by the manufacturer.

� Dithiothreitol (DTT, 1 M): Dissolve 1.54 g DTT in 10 mL of distilled water. Make 1 mL aliquots and

store them at �20�C for 4–6 months.

Note: Wear gloves and prepare in a fume hood.

� Ethylenediaminetetraacetic acid [EDTA, pH 8 (0.5M)]: Dissolve 14.61 g EDTA in 80mL of distilled

water. Adjust pH to 8 with 1 M NaOH solution. Sterilize by autoclaving at 121�C for 20 min, and

store at 4�C for 4–6 months.

Note: Initially, the solution will be turbid and turn clear only when the pH reaches 8.

� Ethylene glycol tetraacetic acid [EGTA, pH 8 (0.5M)]: Dissolve 19.02 g EGTA in 100mL of distilled

water. Adjust pH to 8 with 1 M NaOH solution. Sterilize by autoclaving at 121�C for 20 min, and

store at 4�C for 4–6 months.

Note: Initially, the solution will be turbid and turn clear only when the pH reaches 8.

� Ficoll 400: Use fresh powder.

� Flg22 peptide (10 mM): Dissolve the powder provided by the manufacturer in Milli-Q water to a

10 mM stock concentration. Store in 10 mL aliquots at �20�C for one year.

� Gentamycin (50 mg/mL): Dissolve 1 g gentamycin in 20 mL of Milli-Q water. Sterilize with a 0.2 mm

filter, and store in 1 mL aliquots at �20�C in the dark for 4–6 months.

� Glycerol (50% v/v): Take 50 mL glycerol and add distilled water to make up the volume to 100 mL.

Sterilize by autoclaving at 121�C for 20 min, and store at room temperature (23�C–25�C) for 4–
6 months.

� Hepes-KOH, pH 8 (1 M): Dissolve 23.83 g Hepes in 100 mL of distilled water. Adjust pH to 8 with

1 M KOH solution and store at 4�C for 4–6 months.

� Hepes-KOH, pH 7.4 (1 M): Dissolve 23.83 g Hepes in 100 mL of distilled water. Adjust pH to 7.4

with 1 M KOH solution and store at 4�C for 4–6 months.

� Kanamycin (50 mg/mL): Dissolve 1 g kanamycin in 20 mL of Milli-Q water. Sterilize with a 0.2 mm

filter, and store in 1 mL aliquots at �20�C in the dark for 4–6 months.

� Magnesium chloride (MgCl2, 1 M): Dissolve 9.521 g MgCl2 in 100 mL of distilled water, and store

at room temperature (23�C–25�C) for maximum 1 year.

� 2-[N-morpholino] ethanesulfonic acid (MES, 1 M): Dissolve 1.952 g MES in 10 mL of distilled wa-

ter, and store at 4�C for maximum 1 month.
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� Percoll: Use as provided.

� PEG 6000: Use fresh powder.

� Rifampicin (25 mg/mL): Dissolve 500mg rifampicin in 20mL of DMSO. Sterilize with a 0.2 mmfilter,

and store in 1- mL aliquots at �20�C in the dark for 4–6 months.

� Sodium bicarbonate (NaHCO3, 1 M): Dissolve 8.401 g NaHCO3 in 100 mL of distilled water, and

store at room temperature (23�C–25�C) for 4–6 months.

� Sodium chloride (NaCl, 5 M): Dissolve 29.22 g NaCl in distilled water. Make up the volume to

100 mL with distilled water. Sterilize by autoclaving at 121�C for 20 min, and store at room tem-

perature (23�C–25�C) for 4–6 months.

� Sodium dodecyl sulfate (SDS, 10%w/v): Dissolve 10 g SDS in 80mL distilled water in a beaker. Put

a magnetic flea and place the beaker on a magnetic stirring plate to mix the solution. Once the

powder is dissolved completely, make up the volume to 100 mL with distilled water and store

at room temperature (23�C–25�C) for 4–6 months.

Note: SDS is highly hazardous. Wear gloves and masks and work in a fume hood while

handling the powder to avoid inhalation.

� N,N,N0,N0-tetramethylethylenediamine (TEMED): Use fresh from the bottle.

� Tris-HCl, pH 8.8 (1.5 M): Dissolve 181.65 g Tris Base in 400 mL distilled water and then add

concentrated HCl to bring pH to 8.8. Make up the volume to 1 L, autoclave for sterilization, and

store at room temperature (23�C–25�C) for 4–6 months.

� Tris-HCl, pH 6.8 (1 M): Dissolve 121.1 g Tris Base in 400 mL distilled water and then add concen-

trated HCl to bring pH to 6.8. Make up the volume to 1 L, autoclave for sterilization, and store at

room temperature (23�C–25�C) for 4–6 months.

Preparation of buffers

Timing: 2–3 days

Note: Always prepare fresh infiltration buffer before use.

Infiltration buffer. Freshly prepared at room temperature (23�C–25�C). Use immediately.

Reagent Stock concentration Working concentration Amount for 100 mL

MgCl2 1 M 10 mM 1 mL

MES 1 M 10 mM 1 mL

AS 150 mM 150 mM 100 mL

Distilled water Up to 100 mL

Chloroplast isolation buffer. Stored at 4�C for maximum 1 month.

Reagent Stock concentration Working concentration Amount for 100 mL

Hepes-KOH, pH 8 1 M 20 mM 2 mL

MgCl2 1 M 5 mM 0.5 mL

EDTA, pH 8 0.5 M 5 mM 1 mL

EGTA, pH 8 0.5 M 5 mM 1 mL

NaHCO3 1 M 10 mM 1 mL

D-sorbitol – 0.33 M 6 g

Protease inhibitor cocktail 1 tablet

Distilled water Up to 100 mL
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Note: Always prepare fresh percoll solution before use.

Note: Always prepare fresh gradient mixture solution before use.

Note: Store the Bottom and Top solutions at �20�C for maximum 1 month.

Gradient mixture. Freshly prepared on ice or at 4�C. Use immediately.

Reagent Stock concentration Working concentration Amount for 100 mL

Hepes-KOH, pH 8 1 M 25 mM 2.5 mL

EDTA pH 8 0.5 M 10 mM 2 mL

D-sorbitol 5% (w/v) 5 g

Distilled water Up to 100 mL

Percoll gradient solution. Stored at �20�C for maximum 1 month.

Reagent Percoll solution Gradient mixture

Bottom 51 mL 9 mL

Top 58.8 mL 81.2 mL

Percoll solution. Freshly prepared on ice or at 4�C. Use immediately.

Reagent Working concentration Amount for 120 mL

Percoll 95% (w/v) 114 mL

PEG 6000 3% (w/v) 3.6 g

Ficoll 400 1% (w/v) 1.2 g

BSA 1% (w/v) 1.2 g

Protease inhibitor cocktail – 1 tablet

Distilled water Up to 120 mL

HM buffer. Stored at 4�C for maximum 1 month.

Reagent Stock concentration Working concentration Amount for 100 mL

Hepes-KOH, pH 8 1 M 50 mM 5 mL

MgCl2 1 M 5 mM 0.5 mL

Protease inhibitor cocktail 1 tablet

Distilled water Up to 100 mL

HS buffer. Stored at 4�C for maximum 1 month.

Reagent Stock concentration Working concentration Amount for 100 mL

Hepes-KOH, pH 8 1 M 50 mM 5 mL

D-sorbitol – 0.33 M 6 g

Protease inhibitor cocktail 1 tablet

Distilled water Up to 100 mL

Percoll gradient preparation. Stored at 4�C for 12–16 h.

Percoll solution Volume

Bottom 3 mL

Top 7 mL
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Note: Store the Bottom and Top solutions at �20�C for maximum 1 month.

Note: First, take the Bottom solution in a glass vial and gently pour the Top solution without

disturbing the Bottom. Be gentle while adding Top solution and avoid mixing.

Note: Gradients can be poured a day before and stored at 4�C.

Note: It is recommended to use freshly prepared buffer. If required, buffer w/o protease in-

hibitor can be prepared and stored at 4�C for up to one month.

Note: Sterilize using filter sterilization. Prepare 1 mL aliquots and store at�20�C for maximum

6 months.

Protein extraction buffer. Stored at 4�C for maximum 1 month.

Reagent
Stock
concentration

Working
concentration

Amount
for 100 mL

Hepes-KOH, pH7.4 1 M 20 mM 2 mL

EDTA, pH 8 0.5 M 2 mM 0.4 mL

EGTA, pH 8 50 mM 2 mM 4 mL

NaF Use fresh powder 25 mM 0.1049 g

Na3VO4 Use fresh powder 1 mM 0.01839 g

Glycerol 50% (v/v) 10% (v/v) 20 mL

NaCl 5 M 150 mM 3 mL

Triton X-100 Directly from bottle 0.5% (v/v) 0.5 mL

Protease inhibitor cocktail - - 1 tablet

Distilled water - - To make up 100 mL

Laemmli buffer sample (43) (Wang et al., 2016(Wang et al., 2016))

Reagent Stock concentration Working concentration Amount for 100 mL

Tris-HCl, pH 6.8 1 M 200 mM 2 mL

Glycerol 100% (v/v) 40% (v/v) 4 mL

SDS Powder 8% 0.8 g

DTT 1 M 400 mm 0.4 mL

Bromophenol blue 1% 0.02% 0.2 mL

Distilled water - - To make up 100 mL

SDS-PAGE: Resolving Gel. Freshly prepared at room temperature (23�C–25�C). Use immediately.

Reagent Stock concentration

Gel concentration (required for 10 mL)

10% 12%

Acrylamide mix 30% 3.3 mL 4 mL

Tris-HCl, pH 8.8 1.5 M 2.5 mL 2.5 mL

SDS 10% 0.1 mL 0.1 mL

APS 10% 0.1 mL 0.1 mL

TEMED - 0.004 mL 0.004 mL

Distilled water - 4 mL 3.3 mL
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Running buffer (13). Freshly prepared at room temperature (23�C–25�C). Use immediately.

Reagent
Stock
concentration

Working
concentration

Amount
for 1 L

Tris-HCl, pH 8.3 1 M 25 mM 25 mL

SDS 10% (v/v) 0.1% 10 mL

Glycine Powder 192 mM 144 g

Distilled water - - To make up 1 L

Transfer buffer (13). Freshly prepared at room temperature (23�C–25�C). Use immediately.

Reagent
Stock
concentration

Working
concentration

Amount
for 1 L

Tris-HCl, pH 8.3 1 M 25 mM 25 mL

Glycine Powder 192 mM 144 g

Distilled water - - To make up 1 L

Coomassie blue brilliant (CBB) staining solution. Stored at room temperature (23�C–25�C) for maximum 1 year.

Reagent
Working
concentration

Amount
for 1 L

Coomassie brilliant
blue R-250

0.1% (w/v) 1 g

Methanol 50% (v/v) 500 mL

Acetic acid 10% (v/v) 100 mL

Distilled water - To make up 1 L

Coomassie blue brilliant (CBB) destaining solution. Stored at room temperature (23�C–25�C) for maximum 1 year.

Reagent
Working
concentration

Amount
for 1 L

Methanol 50% (v/v) 500 mL

Acetic acid 10% (v/v) 100 mL

Distilled water - To make up 1 L

Ponceau S staining solution. Stored at room temperature (23�C–25�C) for maximum 1 year.

Reagent
Working
concentration

Amount
for 1 L

Ponceau S 0.1% (w/v) 1 g

Acetic acid 5% (v/v) 50 mL

Distilled water - To make up 1 L

SDS-PAGE: Stacking Gel. Freshly prepared at room temperature (23�C–25�C). Use immediately.

Reagent Stock concentration
Gel concentration
4.5% (5 mL)

Acrylamide mix 30% 0.83 mL

Tris-HCl, pH 6.8 1 M 0.63 mL

SDS 10% 0.05 mL

APS 10% 0.05 mL

TEMED - 0.005 mL

Distilled water - 2.7 mL
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Note: Adjust the pH to 7.4, and autoclave.

PBST buffer (membrane wash buffer) (13). Freshly prepared at room temperature (23�C–25�C). Use
immediately.

Add 0.02% (v/v) Tween-20 to PBS and mix well without making froth.

STEP-BY-STEP METHOD DETAILS

Transient expression in N. benthamiana

Timing: 2–3 days

Here we show an example with C4-GFP and C4G2A-GFP proteins. The non-myristoylable version of

the C4 protein, C4G2A, which localizes in chloroplasts exclusively, was included as control to confirm

in further steps that (i) our chloroplast fractionation is working properly, and (ii) there are no changes

in the stability of the chloroplast-localized proteins upon flg22 treatment.

1. Culture the A. tumefaciens strain GV3101 harboring the corresponding binary vectors in 10 mL

liquid LB with the appropriate antibiotics at 28�C, shaking at 180 rpm overnight (12–16 h).

2. Next morning, harvest the bacteria by centrifugation at 4,0003 g for 10 min and resuspend in the

infiltration buffer (10 mMMgCl2, 10 mMMES pH 5.6, 150 mM acetosyringone) to an OD600 = 0.2-

0.6. Volume of the resuspension buffer can be adjusted according to required OD.

3. Incubate the bacterial suspensions at room temperature (23�C–25�C) in dark for 2 h to allow ace-

tosyringone to induce the expression of vir genes.

4. Infiltrate into the abaxial side of leaves of four-week-old N. benthamiana plants with a 1 mL nee-

dle-less syringe. According to our experience, it is suggested to infiltrate two leaves per plant to

obtain the desired levels of protein. It is recommended to use the third and fourth youngest

leaves, which would be fully expanded. See Figure 2.

Note: For experiments that require co-infiltration, A. tumefaciens suspensions carrying

different constructs need to be mixed at a 1:1 ratio before infiltration.

5. Infiltrate the suspension until the whole leaf area appears translucent. Use as much of the bacte-

rial suspension as necessary.

Note: After the infiltration, ensure that the infiltrated leaves do not touch each other and

gently dry the excess bacterial suspension with a paper towel.

Note: To overcome host antiviral RNA silencing, viruses encode RNA silencing suppressors

(VSRs) that efficiently inhibit host antiviral responses by interacting with the key components

of cellular silencing machinery. The use of VSRs is justified when the accumulation of the pro-

tein of interest is low., Therefore, co-infiltration with a silencing suppressor (e.g., P19 from the

tombusvirus Tomato bushy stunt virus (Qu and Morris, 2002)) is required to prevent silencing

of the transgene and allow high protein accumulation.

PBS buffer (13). Stored at room temperature (23�C–25�C) for maximum 1 year.

Reagent Working concentration Amount for 1 L

NaCl 140 mM 8.2 g

KCl 30 mM 0.22 g

Na2HPO4 1 mM 1.42 g

KH2PO4 1.8 mm 0.24 g

Distilled water – To make up 1 L
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Note: In order to reduce the effects of plant-to-plant variation, it is recommended to express

the protein of interest in at least six individual leaves from three different plants. Assays should

be performed in at least three biological replicates.

Confirmation of protein accumulation

Timing: 2–4 h

Figure 2. Transient expression in N. benthamiana leaves, and confirmation of protein accumulation by confocal

microscopy

(A) Selected leaves from a four-wee-old plant.

(B) Selected leaves agroinfiltrated into the abaxial side with a 1 mL needle-less syringe.

(C) Localization of the WT and the non-myristoylable (C4G2A) C4 versions fused to GFP. Zoom-out pictures: scale bar =

50 mm. Zoom-in pictures: scale bar = 10 mm. AF, autofluorescence.

(D) Two days post-agroinfiltration, CHX is infiltrated with a 1 mL needle-less syringe into the abaxial side of the same

leaves previously agroinfiltrated.

(E) Two hours later, flg22 (or mock solution) is infiltrated with a 1 mL needle-less syringe into the abaxial side of the

same leaves previously treated with CHX.
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It is necessary to carry out this step before continuing with the experiment to confirm that the protein

of interest accumulates homogeneously in the infiltrated leaves.

6. Two days after the A. tumefaciens infiltration, cut small leaf discs from the plants expressing C4-

GFP and C4G2A-GFP with a corkborer with plunger (4 mm diameter).

7. Place the discs on a microscope slide. Put a drop of water and cover with a coverslip.

8. Observe under a confocal microscope using a GFP filter with excitation/emission: 488/500–

550 nm. In this work, images were obtained with a Leica TCS SP8 confocal microscope (Leica Mi-

crosystems) LAS-X 2.01 software using the preset settings for GFP (Ex: 488 nm, Em: 500–550 nm).

See Figure 2.

9. Chloroplast can be visualized using chlorophyll autofluorescence at excitation/emission: 488/

650–700 nm. See Figure 2.

Note: One may use any confocal microscope with the given settings.

Inhibitor and elicitor treatments

Timing: 3–4 h

Here, we show the example with the TYLCV C4 protein.

10. Two days after the Agrobacterium infiltration, and after verifying protein accumulation, infiltrate

the N. benthamiana leaves expressing the viral protein C4-GFP with the translation inhibitor

CHX (180 mM). See Figure 2.

11. After 2 h of incubation, infiltrate one-half of the leaf with the PAMP flg22 (1 mM), and the other

half with water as mock. See Figure 2.

12. For protein and chloroplast isolations, harvest 6 leaves (2 leaves from each plant) after 6–8 h and

proceed immediately using fresh tissue.

13. For visualization, harvest the leaf samples after 12–24 h and confirm the subcellular localization

under the confocal microscope.

Note: For steps 12 and 13, the incubation times must be adjusted according to the accumu-

lation levels of the protein under study.

Note: Under the working conditions indicated throughout this protocol, CHX incubations of

less than 24 h did not produce a toxic effect on N. benthamiana leaves.

Protein relocalization analysis using fluorescence microscopy

Timing: 4–6 h

Visualization of subcellular localization and relocalization

Timing: 2 h

(See Figure 3)

14. After 16 h of flg22 or mock treatment, cut small leaf discs from the plants expressing C4-GFP and

C4G2A-GFP with a corkborer with plunger (4 mm diameter).

15. Place the discs on a microscope slide. Put a drop of water and cover with a coverslip.

16. Observe under a confocal microscope using GFP filter with excitation/emission: 488/500–

550 nm.
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Figure 3. Protein relocalization analysis in N. benthamiana leaves using fluorescence and biochemical methods

(A) Selected leaves from a four-week-old plant after treatment. A detail of the corkborer with plunger used to collect leaf discs for confocal microscopy is

provided in the picture.

(B) Detail of the collected leaf discs placed on a microscope slide and cover with a coverslip.

(C) Leica TCS SP8 confocal microscope (Leica Microscopy) used in this protocol.

(D) Localization of C4-GFP following treatment with 1 mM flg22 (16 h post-treatment) in the presence of CHX (50 mg/mL, 2 h prior to flg22 treatment).

Scale bar, 10 mm. AF, autofluorescence. For detailed information regarding protein quantification using ImageJ, see Figure 4 and Methods video S1.

(E) Intact chloroplasts separated at the interphase of a two-step Percoll gradient.

(F) Western blots showing the differential accumulation of C4-GFP protein in PM and chloroplasts upon flg22 treatment. The chloroplastic form C4G2A-

GFP shows no change upon elicitation. Asterisks indicate unidentified bands, potential degradation products of the PM C4-GFP pool. Protein size in

kDa are indicated. Numbers below blots indicate relative intensity (for further information, see Figure 5 and Methods video S2). Total: total protein;

Chloroplast: protein from the isolated chloroplasts fraction. C4-GFP: PM-localized C4-GFP; cpC4-GFP: chloroplast form of C4-GFP. Panel reprinted

with permission from Medina-Puche et al. (2020).
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17. Chloroplast can be visualized using chlorophyll autofluorescence at excitation/emission: 488/

650–700 nm.

18. The C4 protein localizes to both plasma membrane (PM) and chloroplasts, whereas C4G2A local-

izes to chloroplasts only.

19. To quantify the proportion of protein localized to PM and chloroplasts with and without elicita-

tion by flg22, the ratio of GFP-fluorescence intensity at PM and chloroplast can be used. For this

quantification, the confocal images can be analyzed using the ImageJ software (https://imagej.

nih.gov/ij/) as described in the next section.

Alternatives: For step 19 and further, the open-source image processing package Fiji (Fiji Is

Just ImageJ; https://fiji.sc/) can be used as well. Note: For step 14, elicitation time must be

adjusted for every protein of interest.

Quantification of protein subcellular localization using ImageJ

Timing: 2–4 h

(See Figures 3 and 4, and Methods video S1)

20. Analysis of the confocal images can be done with the ImageJ software (https://imagej.nih.gov/

ij/; see Figure 4 and Methods video S1) as follows:

a. Place all images for analysis into one folder. All images should have the same channel. Click

on ‘‘Image’’ menu in the toolbar and make sure that ‘‘Green’’ (if your proteins are tagged to

GFP) is selected among ‘‘Lookup Tables (LUT)’’ options.

b. Next, click on the ‘‘Process’’ menu in the toolbar and select ‘‘Substract Background’’. Unclick

all the options and set 50 by default.

c. Then, click on ‘‘Image’’ in the toolbar, select ‘‘Adjust’’, and click on ‘‘Brightness/Contrast’’.

Set same value for all images.

d. In the toolbar, click on the ‘‘Hand lens’’ icon. Then, set a defined ‘‘Region of Interest’’ (ROI)

size in the ‘‘ROI Manager menu’’, save, and apply to all images during analysis.

e. Then check the ‘‘Grey Mean Value’’ icon in the ‘‘Set Measurements’’ icon of the ‘‘Analyze’’

menu in the toolbar.

f. Click ‘‘Measure’’ under the ‘‘Analyze’’ menu to get the intensity values.

g. Export the values of the selected areas into a spreadsheet.

h. Calculate the final relative quantification values as the ratio of PM to chloroplast fluorescence

intensity.

Biochemical analysis of protein relocalization

Timing: 3–4 days

Chloroplast isolation

Timing: 4–5 h

CRITICAL: For isolation of intact chloroplasts (Figure 3), use fresh tissue. Do not freeze the

samples.

Figure 4. Quantification of protein subcellular localization using ImageJ

(A) Screenshots showing step-by-step pipeline using ImageJ for confocal images.

(B) Analysis of the signal intensity values obtained from the confocal images corresponding to one pair of pictures from all the images from one

replicate.

(C) Column chart representing the calculated PM-to-chloroplasts intensity ratio of C4-GFP protein reprinted with permission from Medina-Puche et al.

(2020). Bars represent SE of n = 6. Asterisks indicate a statistically significant difference (***p = 0.0004) according to a two-tailed comparisons t test.
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Note: Check the expression of the GFP-tagged protein by confocal microscopy prior to chlo-

roplast isolation.

Note: Carry out the chloroplast isolation in low or dim light (20 mmol m�2 s�1).

Note: It is better to perform the experiment in a cold room, if possible. Otherwise, keep every-

thing at 4�C; solutions, rotors, equipment pre-cooled to 4�C; centrifugations should be per-

formed at 4�C (unless otherwise indicated).

Note: Plant leaf materials should be collected into a beaker placed on ice.

Note: Use wide-bore 1 mL tips for the isolation of chloroplasts. Cut 2 mm off the tip of 1 mL

pipetman tips using a razor blade, autoclave and dry them.

Note: Please refer to (Dogra et al., 2019; Kauss et al., 2012).

21. Grind the tissue (around 6 leaves of four-weeks-old N. benthamiana plants in 50 mL of isolation

buffer in a Waring blender (3 times, each for 3 s).

22. Filter the homogenate through 4 layers of Miracloth into a 50 mL polypropylene tube

and centrifuge at 400 3 g for 8 min. Collect the pellet and resuspend in 1 mL of isolation

buffer.

Alternatives: In case of using Arabidopsis transgenic plants, rosette leaves of 50 to 60 3-

weeks-old plants should be used for chloroplasts isolation.

Note: If using more than one tube, suspend the pellet of each tube in approximately 250 ml

isolation buffer and pool all the suspensions together.

23. Load approximately 500–1000 mL of chloroplast suspension on the two-step Percoll gradient.

Centrifuge in a swing-out rotor at 200 3 g for 20 min with brakes off.

24. Remove broken chloroplasts and Percoll till the layer of intact chloroplasts between the two Per-

coll steps. Take intact chloroplasts using a wide-bore tip, place into 50 mL tube (chloroplasts

from several gradients can be combined), fill with HS buffer up to 50 mL invert the tube several

times, and centrifuge at 400 3 g for 6 min.

25. Resuspend the chloroplast pellet in another 50 mL of HS buffer and centrifuge at 400 3 g in for

6 min. Resuspend chloroplast pellet in 1 mL of HS buffer.

26. Take a 10 mL aliquot, add 990 mL of 80% acetone to it, vortex, centrifuge for 5 min at 21,0003 g

at room temperature (23�C–25�C). Take clear supernatant and measure OD652 using quartz or

glass cuvette. Calculate chlorophyll concentration as:

Chl (mg/mL) = (OD652 3 dilution factor)/36

In our case, the dilution factor was 100. This normalization will be used in all downstream

experiments.

27. For the lysis of the intact chloroplasts, take such a volume intact chloroplasts suspension that

corresponds to a desired amount of chlorophyll, (you can take intact chloroplasts corresponding

to 200 mg of chlorophyll amount as shown in #26) and pellet down at 2600 3 g for 5 min. Resus-

pend the pellet in 150 mL of HM buffer and keep on ice for 10 min.

28. Centrifuge at 2600 3 g for 5 min. Separate the supernatant as stroma fraction (150 mL) and the

pellet as membrane (envelopes and thylakoids) fraction. Remove contaminants by washing the

membrane fraction with HS buffer.
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Protein isolation from plant tissue and isolated chloroplasts and western blotting

Timing: 1–2 days

(See Figure 3)

29. For isolating total proteins from fresh plant tissue and total proteins from isolated chloroplasts:

a. Collect 2 leaf discs with an 8-mm punch from each leaf (usually 6 leaves from 3 plants in case

of N. benthamiana) to be used for total protein isolation. Grind the leaf discs in liquid nitro-

gen and collect in 2 mL tubes. Keep the tubes at �80�C or in liquid nitrogen, and wait until

chloroplasts are isolated (as described in steps 21–28).

b. Isolate intact chloroplast from the leaves from which leaf discs are extracted (as described in

steps 21–28).

c. Resuspend the chloroplast pellet from (b), corresponding to 1000 mg of chlorophyll (concen-

tration usually 1 mg/ul), in 1 mL protein extraction buffer.

d. Resuspend the leaf disc powder from (a) in 500 ul protein extraction buffer.

e. Incubate the tubes from (c) and (d) for 30 min on a revolver lab rotator at 4�C.
f. Centrifuge at 21,0003 g for 30 min at 4�C. Collect the supernatant in a new tube and repeat

the centrifugation step.

g. Final supernatants collected from the tubes from (c) and (d) represent chloroplast and total

proteins, respectively.

30. Take 150 mL of total and chloroplast protein samples and add 50 mL of 43 Laemmli sample buffer

to make the final volume to 200 mL. Denature at 95�C for 10 min.

31. Load equal amounts of the solubilized protein fractions on 10% SDS-PAGE gels.

32. Transfer the gel to the PVDF membranes via wet or semi-dry transfer methods.

33. The target protein can be visualized using the specific antibody (tag-specific antibody, if the

target protein is fused to tag). Light-harvesting complex proteins (LhcBs) and Rubisco large sub-

unit proteins (RbcL) can be used as membrane and stroma marker proteins, respectively, and

can be detected using specific antibodies commercially available (see key resources table).

Stain the gel with CBB and the membrane with Ponceau S staining to confirm equal loading.

Quantification of proteins bands in western blots using ImageJ

Timing: 2 h

(See Figures 3 and 5, and Methods video S2)

34. This section will allow you to quantify the intensity of protein bands from western blots with the

ImageJ software (https://imagej.nih.gov/ij/). The quantification will retrieve the relative

amounts as a ratio of each protein band relative to the corresponding loading control band

(see Figure 5 and Methods video S2).

a. Before starting, make sure you make a copy of your original raw images, save them as JPEG

file format, and transform the images mode to ‘‘Grayscale’’. As reference, Photoshop (or

similar software) may be used in this step.

b. Set up the measurement criteria you will apply to all the blots to analyze. In the toolbar, click

on the ‘‘Analyze’’ menu and select ‘‘Set Measurements’’. From the checkboxes, keep only the

‘‘Mean gray value’’ checked.

c. Next, click on the ‘‘File’’ menu in the toolbar, and open the JPEG file images generated pre-

viously. Maximize the window and adjust an appropriate zoom level.

d. Set a defined ‘‘Region of Interest’’ (ROI) size according to the largest band among the target

bands of a sample on the blot. In the toolbar, click on the ‘‘Analyze’’ menu, and next on

‘‘Tools’’. Then, set a defined ‘‘Region of Interest’’ (ROI) size in the ‘‘ROI Manager menu’’.

Select the ‘‘rectangle’’ tool and draw a frame around the largest band. Adjust the size of
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Figure 5. Quantification of protein bands in western blots using ImageJ.

(A) Screenshoots of the step-by-step pipeline using ImageJ for the analysis of band intensity in western blots. The western blot and the acrylamide gel

reprinted with permission from Medina-Puche et al. (2020).

(B) Analysis of the signal intensity values obtained from the protein samples (WB) relative to the corresponding loading control (CBB).
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the frame so that it covers the minimum area. Click the ‘‘File’’ menu in the toolbar, ‘‘Save as’’,

‘‘Selection’’ and save this frame. Use the same frame for all the protein bands you need to

analyze from the same blot. If you accidentally resize the frame or lose it, go to the ‘‘File’’

menu, ‘‘Open’’, and reimport the same frame again.

e. Put the frame so that the band is inside, click the ‘‘Analyze’’ menu, ‘‘Measure’’, and get the

intensity values. Move the frame to the following bands and repeat this step in order to

get the intensity values for all the samples.

f. Next, export the values into a spreadsheet keeping track of which value corresponds to which

sample.

g. Repeat the steps ‘‘e’’ and ‘‘f’’ to take a background measurement using the same frame as for

the protein bands. Put the frame above or below every band on the row where there are no

other bands, get the intensity values, and export into the spreadsheet.

h. For the loading control bands, repeat the same steps (‘‘e’’ to ‘‘g’’) as described for the sample

bands.

35. With all the values in the spreadsheet, you can proceed to do the calculations.

a. Apply the formula 255 – X, where X is the intensity value recorded for each band or loading

control and their respective background values, to invert the pixel density for all data.

b. Next, calculate the net value for the protein bands and the loading controls by deducting the

inverted background value from the inverted band value calculated in ‘‘a’’.

c. Finally, calculate the relative value as the ratio of a net band value over the corresponding net

loading control.

Note: Save high-resolution images or scans from the blots or films, respectively (600 dpi in

TIFF file format is recommended). Save them as raw images, and do not save any change

over these original files.

Immunoprecipitation-based detection of low abundant proteins

Timing: 4–5 h

Note:We recommend carrying out this section if the accumulation of the protein of interest is

too low.

36. Isolate total proteins and total chloroplast proteins as described above.

37. Filter the isolated proteins through a 0.22 mm Millipore Express PES membrane.

38. Quantify the proteins using standard protocols, e.g., the PierceTM BCA protein assay kit

(Thermo Fisher Scientific).

39. Prepare the isolated protein as the Input samples: take 150 mL of isolated chloroplast protein

samples and add 50 mL of 43 Laemmli sample buffer to make the final volume to 200 mL. Dena-

ture at 95�C for 10 min.

40. Take the desired amount of protein (ideally 2–10 mg) and add 25 mL of antibody-conjugated

beads, e.g., GFP-Trap Agarose beads (ChromoTek) in the case of GFP-tagged target protein.

41. Incubate the samples with agitation at 4�C for 1.5–2 h.

42. Centrifuge at 2500 3 g for 30 s.

43. Take out the supernatant and wash the beads four times for 5 min with wash buffer (PBS with

0.05% Triton X-100).

44. Elute the bound proteins in 100 mL 13 Laemmli SDS sample buffer with incubation for 20 min

at 70�C.
45. Load equal amounts of the input and IP-eluted samples on 10% SDS-PAGE gels (for detecting

bait (target) protein, load 10 mL, whereas for the prey (interactor) the loading can vary depend-

ing upon the interaction strength and the protein abundance.

46. Transfer the gel to the PVDF membranes via wet or semi-dry transfer methods.
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47. The protein of interest can be visualized using a specific antibody or a tag-specific antibody

(e.g., anti-GFP antibody), if the target protein is fused to a tag. Stain the gel with CBB and

the membrane with Ponceau S to show equal loading.

48. Quantification can be done as described in steps 34 and 35.

EXPECTED OUTCOMES

The multifunctionality of a protein may rely on its versatile accumulation in distinct subcellular compart-

ments in response to internal andexternal stimuli. Thisdynamic relocalizationofproteins canbevisualized

and quantified through different methods. By combining microscopy-based methods and biochemical

approaches, we aim to provide an easy-to-do method that enables the reliable and robust visualization

and quantification of the dynamic protein accumulation in different subcellular compartments.

LIMITATIONS

Agrobacterium-mediated transformation efficiency is sensitive to temperature, so the growing con-

ditions must be controlled and optimized.

A desired protein accumulation can be compromised by posttranscriptional (e.g., gene silencing) or

posttranslational (e.g., induced cell death) effects. In order to circumvent these issues, a silencing

suppressor (e.g., P19) could be used, or the expression of the transgene can be driven by an induc-

ible promoter.

The subcellular localization of proteins is highly dependent onposttranslationalmodifications, and these,

in turn, can be modulated by various environmental and developmental signals. It is therefore vitally

important thatplantsgrowunder controlledgrowingconditions, avoidingbothabiotic andbiotic stresses.

TROUBLESHOOTING

Problem 1

N. benthamiana leaves are hard to infiltrate (steps 4, 5, 10, and 11).

CRITICAL: make sure not to press the needleless syringe so hard as to pierce the leaf

through.

Potential solution

Water the N. benthamiana plants 30 min before using.

Create a small nick with a needle or blade in the epidermis on the back side of the leaf. Please, make

sure not to scratch so hard as to pierce the leaf through otherwise, the Agrobacteria inoculum will

pass through the puncture.

Problem 2

The protein accumulation is very low as observed under the confocal microscope (step 8).

Potential solution

Host gene silencing can prevent accumulation of transcripts of the transgene; in such cases, viral

silencing suppressors, such as P19, can be co-expressed.

When transiently accumulated in planta, some proteins can trigger cell death, leading to their

reduced accumulation. In that case, changing the constitutive promoter to an inducible one could

enable a controlled expression.
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Detect the fluorescence with a more sensitive detector for confocal imaging. In our protocol, the Le-

ica TCS SP8 confocal microscope (Leica Microscopy) provides a Hybrid Detector (HyD) for super-

sensitive imaging.

Problem 3

The protein accumulation is very low as observed in the western blot (Protein isolation from plant

tissue and isolated chloroplasts, and western blottingsection; steps 29–33).

Potential solution

Host gene silencing can prevent accumulation of transcripts of the transgene; in such cases, viral

silencing suppressors, such as P19, can be co-expressed.

When transiently accumulated in planta, some proteins can trigger cell death, leading to their

reduced accumulation. In that case, changing the constitutive promoter to an inducible one could

enable a controlled expression.

Scale up the amount of agroinfiltrated tissue in order to increase the amount of accumulated protein.

For biochemical detection on western blot, low abundant proteins can be enriched by using immu-

noprecipitation (see immunoprecipitation-based detection of low abundant proteins section; steps

36–48).

Use high sensitivity enhanced chemiluminescence (ECL) substrates for western blot detection and/or

long exposure times to enable the detection of low-abundance proteins.

When CCD-based imaging does not provide enough sensitivity, use X-ray film as is generally consid-

ered to be the most sensitive method for detecting relative protein levels.

Problem 4

Low yield of isolated intact chloroplasts (chloroplast isolation section; steps 21–28 ).

Potential solution

While homogenizing the leaf samples in the blender, do not give more than 3 bursts of 3 s.

For separating intact chloroplasts in the Percoll gradient, make sure that both acceleration and

deceleration are very slow during centrifugation.

Use cut tips for recovering the layer of intact chloroplasts.

Problem 5

In some cases, when the size of the protein of interest is small, GFP-tagged proteins are hard to

differentiate from free GFP. This is largely because the difference between the size of the GFP-

tagged protein and free GFP is not big enough to nicely separate them on the gel (protein isolation

from plant tissue and isolated chloroplasts, and western blotting section; steps 29–33).

Potential solution

Run the proteins on the gel for a longer time.

Use a longer gel.

Try higher acrylamide concentration or bis acrylamide/acrylamide ratio.
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RESOURCE AVAILABILITY

Lead contact

Further information and requests for resources and reagents should be directed to and will be ful-

filled by the lead contacts, Laura Medina-Puche (laura.medina-puche@zmbp.uni-tuebingen.de),

and Vivek Dogra (vivekdogra@ihbt.res.in).

Materials availability

Plasmids generated in this study will be made available on request; a completed Materials Transfer

Agreement may be requested if there is potential for commercial application.

Data and code availability

This study did not generate any unique datasets or code.

SUPPLEMENTAL INFORMATION

Supplemental information can be found online at https://doi.org/10.1016/j.xpro.2021.100816.
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